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Who is @om Cq St and what do they provide in services?

@ Do you watch the Golf Channel?
Who are the people behind this channel?

The Golf Channel, co-founded by Arnold Palmer and a subsidiary of the Comcast
Corporation, is available in more than 90 million homes worldwide through cable,
satellite and

wireless companies.

Come and find out what Comcast has to offer in the way of Internet, Television and
other
services. There is much more to Comcast than what most of know or use.

Comcast Triple Play

This information sheet was done using a Free Program (OpenOffice2.0) if you want to
save some money and need a new Office Suite, check out OpenOffice
(www.openoffice.com).



Bill's Tricks & Tips

Microsoft Word's Insert Button
Have you ever ran into a problem where you move your cursor to edit text on ype A D l'iV e

MS Word and when you type, it ends up overwriting the characters after it?

That is MS's over-write function. In case you ever may need it, tap the
"Insert" button on your keyboard or doubleclick on the bottom part of your MS Word windows that
saids "OVR" (for over-write).

Power Supply Reliability

Lately, there are a lot of power supplies out there that just don't get the job done. A very rough by easy
method of figuring out power supply reliability/strength is, believe it or not, its weight. The more a

power supply weighs, generally, the more powerful and reliable it is. When you think about it, it makes
sense - the more a power supply weighs, the more "stuff" there is inside. Don't overlook your PSU - it's
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open the same tab if in a Windows Explorer window you select the Tools menu. When the View tab is
open put a tick in the Display the Full Path in the Address Bar check box and click Apply. Now you
should be able to see the whole path to a file or folder.



Defragmenting The Hard Drive

Defragmenting your harddrive(s) is a task that you must perform if you frequently copy and delete files
(especially small ones) from your harddrive. Essentially, defragmenting the harddrive is nothing more
than rearranging free and used blocks. The idea is that if all used blocks and all free blocks are grouped
separately, searching for files on your harddrive will be faster because all the blocks of a file will be
grouped together and not scattered all around the harddrive. How data is written in files and on the disk
is complicated to explain in a tip but just take it for granted that defragmentation is a general
housekeeping task and has to be performed regularly.

You can make defragmentation a scheduled task that runs at specified times (i.e. at night when you
computer is idle) or you can start it at any time you like. To start the degragmenter, right-click My
Computer icon on the desktop and select Manage. Then go to Storage and click Disk Defragmenter.
Select the drive you want to defragment and click the Defragment button (or you may first click
Analyze button to see if the drive needs defragmenting or not).

Restore Folders at Startup
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If you happen to read a lot onscreen, no wonder

Restors Dafauls | that your eyes start to hurt you even if you have a
top-notch monitor. You can make things better,
ok | Caneel | ey | if you change the background color from white

to pale grey, pale blue, pale green or select a
gradient image for a background. You can do this either for all Windows applications or check if the
particular applications you are using most often allow to change the background color or put an image
(for instance, FireFox allows to change the background color).



Shift+F3 in MS Word

You have typed a whole paragraph of text and now you notice that you have left the Caps Lock on? Or
all of a sudden it dawns on you that in headlines all words start with a capital letter? Don't worry - MS
Word has a really cute keyboard shortcut for changing the case: Shift+F3. The same effect can be
achieved if you select Format -> Change Case. This will open a dialog box you can select how
exactly to change it - to Sentence Case, Upper Case, Lower Case, Title Case or just to toggle the case.

View Folder Bar

The Folder Bar, which displays the folders of your computer in an expandable and collapsible manner,
can be very handy when browsing through the files and folders on your computer. While this feature is
set to appear, by default, in Windows Explorer, it is not shown when viewing My Documents of My
Computer. To make the Folder Bar viewable (from within My Documents or My computer), click on
View > Explorer Bar > Folders. The Folder Bar should now appear in a panel along the left side of
the window.

View Internet History

While in Internet Explorer, one may view a list of recently visited webpages by pressing Ctrl + H or
going to View > Explorer Bar > History. If everything went correctly, a new panel should appear on
the left side of the window. One may now view which sites were recently visited and be able to open
those sites again.

Pressing F4 will also bring up a list of the most recent websites which were typed into the address bar.

FPCUG News

Due to other obligations Ronnie Ugulano will not
be able to continue as Newsletter Editor. There is a
pressing need for someone to fill this role.
Experience with word processing is necessary.

Raffle Item: Fenton 800V A Uninterruptible Power
Supply Tickets only $1!




Spin It Again
By Don Cummins
At this year’s (2007) APCUG Meeting in Las Vegas, Nevada was a Demo put
ﬂ on by a nearby Oakhurst company. You know the company by the name of
Acoustica. They gave us a presentation a few years back on a Disk Labeler

EP \-ng Program called Acoustica

CD/DVD Label Maker, as you may remember.

Acoustica was founded in 1998 and is located in the foothills of the Yosemite Valley. In January 2002,
they officially became Acoustica, Inc.

Acoustica's mission is to create high quality, intuitive and powerful software. With value, diligence,
creativity, and innovation. To ensure maximum customer satisfaction, they provide multiple levels of
support and availability. At Acoustica, the customer comes first!

The demo was on their program Spin It Again.

software-shoud be easy fo yee!

|, ACOUSTICA

It was the best demo I have seen in a long time. The person who did the presentation was the person
who developed the program. He lives in Las Vegas so he was an able to do the presentation himself.
The meeting room was full with about sixty or so members of APCUG. The only drawback was it was
not video taped so everyone could see/hear it. He used a LP from the early 70’s that had been in the
basement of his folk’s home in Illinois. It still had the cover on but was in very bad shape as it was in a
flooded basement a number of years ago. It had not been cleaned. He played the LP on a very old
record player that was connected

to his laptop. The LP had a lot of hisses and pops when played at first and then he made his copy using
Spin It Again to put it on a CD. It was a very good copy when he finished the demo.

I have never owned a LP in my life so I do not know a lot about
them. Go to their website and download a Free Trial. —
wWwWw.acoustica.com ACOUSTICA

Late last year (2006), they gave every member opportunity to
download a free copy of their program Photos Forever. I hope
you all took advantage of the offer. If you did, I hope you sent
them a thank you note via email. If not, it’s not too late to do so.

Soffwars should Be pasy t

The Easy Way to Convert Your LPs and Cassettes to Clean, wiww.acoustics.cam
Digital Recordings. Remember all those 'oldies but goodies'?



They just don't make those classic vinyl LPs and cassette tapes on CD. Well, dust off your old 33s, 45s
& 78s, because Acoustica's new software, Spin It Again™, can easily record any vinyl LP to CD or
cassette to CD. Not only will our software make the whole recording and track dividing process child's
play, but it will also dramatically clean your recordings by getting rid of click and pop record noise, or
by removing hiss and hum off old cassettes. You can also record your LP collection and cassettes to
your iPod or portable MP3 player! So let your music come to life and Spin-It-Again™! If you have a
Windows computer with a soundcard, you're ready to use our software. Give it a try if you have LP’s
and tapes you want to save and play again! It is a great program.

This product will make a great general meeting program. Would anyone like to present it?

Stop! Think! Click!
By_Lou Torraca, President. the MOAA Hawaii Chapter Computer User Group, Hawaii

The world has changed. Today we can work, check bank balances, book travel, research medical
questions, talk to friends and family members, order books and music, bid on auction items, and even
buy a car without leaving home. Thanks to the Internet, we have access to entertainment, shopping,
email and other information, 24 hours a day. This access to information is greater than most folks in my
generation could have ever imagined. However, the Internet is not without hazards. The Internet and
the anonymity it affords can give online scammers, hackers, and identify thieves access to your
computer, personal information, finances and more.

I have written about it before, and so have many others, but [...]  wanted to provide an update on that
Internet bugaboo: SECURITY!!! First of all, for those of you who are concerned about using your
credit cards for Internet purchases, a couple of things to consider: first, most CC companies have either
a $50 maximum amount which you are liable for if someone uses your # without your permission. In
fact, many have a $0 liability policy, sometimes tied to a requirement that you report the use within a
certain time-frame. So, step one should be to check with your CC customer service and find out what
the policy is. Also, it is possible, with many CCs to get a one-time use # which might be a new account
number, or just the 3 digit # on the reverse side of your card. Check with the CC company or the
issuing bank. Obviously, you will want to check your CC account regularly to see if any bogus charges
have been added and this is pretty easy if you setup an online account. Even easier if your issuing bank
or CC company has an alert setup that will notify you if an unusual charge appears. Remember that all
the other security measures that affect your computer, e.g. anti virus, anti spy/malware, firewall,
updating your operating system, etc. further insure your safety. A good reference is:
www.microsoft.com/athome/security/viruses.

The Washington State AARP folks gave an excellent presentation on this topic at the national AARP
convention and graciously gave me their permission to use any parts I wanted to for this column. Here
are a few of the pretty extensive notes I took.

Protect your privacy and personal information online; if you are asked for personal information such as
your name, email, address, telephone number, account numbers, or Social Security number, find out
how the information is going to be used before you share it. Find out how the requester protects your
personal information. Remember, it is your information.

Whether you are shopping, banking, or conducting other business online, do not provide your personal
or financial information through a company's website until you have checked for indicators that the site


mailto:president@the-tug.org

is secure. Look for "https" in the Web address (the "s" stands for secure). Look for a padlock or an
unbroken key in the lower right corner of the status bar. Double-click the padlock or key to ensure that
the "issued by" name on the security certificate matches the name in the address bar.

If you get an email or pop-up message asking for personal information, do not reply or click on the link
in the message. If you think there may be a need to provide information to the requester (you have an
account with the company or have placed an order) con- tact the company directly by telephone. Do not
send your personal information via email; it is not a secure transmission method.

Here is an excellent place to review the topic of phishing: http://microsoft.com/athome/security

Find out how the information is going to be used before you share it. Find out how the requester
protects your personal information. Remember, it is your information."

Anyone can set up shop online. It is a good practice to know whom you are dealing with and what you
are getting into. Proceed with caution in your online activities. If you shop online, check out the seller
before you buy. A legitimate business or individual seller should give you a physical address and a
working telephone number you can call in case you have problems. Call the telephone number before
you buy. Never send cash, personal checks or money orders for online purchases. Check out the terms
of the deal, like refund policies and delivery dates. The law requires sellers to ship items as promised or
within 30 days after the order date if no specific date is promised.

Delete junk email without opening the message. If you open the email, it can alert the spammer that the
address is good. Never reply to spam. This includes responding to an option to "Remove me from your
list." Do not buy anything or give to any charity marketing through spam. Spammers may swap or sell
email addresses of their customers. If you make a purchase as the result of a spam email, it may result
in more spam. Do not forward chain email messages. You lose control over who sees your email
address. You might also be forwarding a hoax aiding in the delivery of a virus.

Delete junk email without opening the message. Do not forward chain email messages. Do not buy
anything or give to any charity marketing through spam.

Passwords are the key to unlocking your computer and online accounts. A strong password provides
better security against hackers and thieves. Strong passwords should be over eight characters in length,
combine letters, numbers, and symbols, and should avoid using common words. Do not use your name,
your spouse's name, your birthday or location.

Change your passwords regularly or at least every 90 days.

Do not use the same password for each online account you use. Keep your passwords secret. Do not
give passwords out to family or friends or send your passwords over email. Do not enable the "Save
Password Option" if you receive a dialog box asking you if you would like the computer to remember
your password. Do not store written passwords on or near your computer.

Record passwords and store in a safe, secure place. One way to create a strong and memorable
password is to think of a "pass phrase." Think of a phrase that is easy to remember like "I save my
pennies for a rainy day." Use the first letter of each word as your password, converting some letters
into numbers that resemble letters; for example "Ism¢4ard." Notice the combination of upper and lower
case letters, numbers and symbols.

Pay attention to what kids do and whom they meet online. Consider a rule that no child reveals
personal information, including photos, without permission. Warn kids never to meet Internet "friends"
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in person. Parental controls are provided by most Internet Service Providers, or sold as separate
software. No software can substitute for parental supervision. Talk to your kids and/or grandkids about
safe computing as well as things they are seeing and doing online.

Stop and think before you click; before you provide information, open files or attachments, or
download files from unknown senders, take a minute to stop and think before you click.

Free downloads can contain spyware. To avoid it, resist the urge to install any software unless you
know exactly what it is. You can install anti-spyware software and then use it regularly to scan for and
delete spyware programs that may sneak onto your computer.

Email attachments and links sent over email will not damage your computer without your participation.
You have to open an email or attachment that includes a virus or follow a link to a site that is
programmed to infect your computer. Hackers use a variety of enticing file names such as "Per your
request!" or "Fwd: FUNNY" to get you to open the email attachment or click on the link. Do not open
an email attachment unless you expect it and know what it contains. You can help others trust your
attachments by including a message in your text that explains what you are attaching.

Do not open an email attachment unless you expect it and know what it contains.

"Instant messaging" is a form of online communication like email. You can type messages to someone
and they can see the messages almost immediately. Files attached to instant messages can also contain
viruses. In most cases, viruses spread when you open an infected file attached to an instant message
appearing to come from someone you know.

Finally, two things, share your knowledge with others so that they will be more vigilant on the 'net and
report abuses, including spam, via the Federal Trade Commission http://www.ftc.gov, your Internet
Service Provider and your bank or credit union. Most have addresses to use that may begin with
phishing, abuse or spoof. Check their web pages for the correct one.

That's it for now, until next time, have fun with all those computer and electronic goodies, but
remember to be careful out there on the 'net!

Aloha, Lou

There is no restriction against any non-profit group using this article as long as it is kept in context
with proper credit given the author. The Editorial Committee of the Association of Personal
ComputerUser Groups (APCUG), an international organization of which this group is a member,
brings this article to you.

Acronis Software Support of WindowsVista
By Gene Barlow User Group Relations

Copyrighted March 2007

On February 7, 2007, Acronis, Inc. announced that it will "fully support Microsoft’s latest operating
system, Vista, with its products for desktop operating systems". This statement of intent has already
been accomplished for two of their most popular products for home users — Acronis True Image 10.0
Home and Acronis Disk Director Suite 10.0. This article will show you how to obtain these Vista
supporting utilities.


http://www.ftc.gov/

Acronis True Image 10.0 Home: This is the top rated backup utility on the market today. It helps you
backup your important data files as well as your entire computer -- operating system, application
programs, and all. Used regularly it will protect your important files from hard drive crashes and other
system problems. Acronis True Image 10.0 Home edition was released three months prior to the release
of Vista, with full support of Vista included in the product. Earlier this month, Acronis made available
build 4942 of True Image to correct any problems with their new release. You should install this new
build to give you the latest True Image software.

Acronis Disk Director Suite 10.0: This is an outstanding partitioning utility to help you organize and
manage your computer’s hard drive. Using this utility, you can have both Windows XP and Vista
running on the same computer. This is a much safer way to start to use Vista rather than instantly
replacing your stable XP system with Vista. Earlier this month, Acronis made available build 2160 of
Disk Director Suite to provide full support of Vista in this excel lent partitioning utility.

So, how does this announcement affect you? There are three options to consider as follows:

Not a User of Acronis Utilities: 1f you do not already use one or both of these excellent Acronis
products, now is the perfect time to get them. We are offering both of these products that normally list
for $50 each at our user group discount price of just $29 each. That price includes a special tutorial
with each product to help you start to use them quickly and safely. To order either or both of these
Acronis products, go to www.usergroupstore.com and place your order using our secure online
ordering system. The order code for this special price is UGNL0307.

Use Older Acronis Utilities: 1f you already have one or both of these Acronis products, but are still
using an older version (prior to version 10.0), you should get the latest release (version 10.0) to be
ready for Windows Vista in the future. Our user group discount prices for these products is lower than
the upgrade price from Acronis, so order a new license of the product from us at a great discount price
and get the tutorials as a bonus. To do this, follow the ordering instructions in the prior paragraph.

Use Version 10 Acronis Utilities: 1f you already use version 10 of these Acronis products, then it is
important that you download the new builds for these products to get the full benefits of your software.
The process to download these new builds is quick and easy to accomplish. There is no charge for these
updates as long as you are a current owner of version 10 of these products. For those that we promised
a free update of Acronis Disk Director Suite 10.0 with Vista support, this is what you need to do.
Follow the instructions below to download these new builds and install them on your computer.

Downloading New Builds from Acronis: To download the new builds from Acronis is quick and easy
to do. There are three steps to accomplish this. First, you must set up an account on the Acronis web
site. Next, you must register the Acronis products you use in your account. Finally, you can download
the latest builds of your registered products from your Acronis account. I describe these three steps in
detail at www.ugr.com/questions.html. Print out these instructions and follow them carefully and you
will have your new builds installed quickly.

I hope this information helps you take advantage of the Vista support in Acronis True Image 10.0
Home and Acronis Disk Director Suite 10.0. Download and install these new builds and your Acronis
software will be ready for Windows Vista when you are. If you have questions about this article or the
downloading of new builds, please send a note to gene@ugr.com and I will try to assist you.

Gene Barlow
User Group Relations
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PO Box 911600
St George, UT 84791-1600

FPCUG Board of Directors Meeting Summary

The following items were discussed or decided upon:

In June, Gary Gipson will be leaving the club when his membership expires. Don Cummins
agreed to take over his job duties at this time as Presentation Coordinator.

Discussion was made regarding bylaws and changing the number of board members from 9 to
7. The primary reason at this time, is that the group is much smaller than it once was.

After following due proceess, Brian Faulk was removed from the board. Kayhan Aminian will
fill in Brian's term.

There was discussion about having a membership list/directory available to all members.
Members would be contacted to determine what information they would want listed.

There was more discussion on having all membership fees due the same month for everyone. It
is expected that this would reduce the amount of time spent on bookkeeping.

Special Interest Groups (SIGs)

If you are a PC Users Group member, join a Special Interest ————F—
group--a great way to share information with others having m—smi d

similar interests. Special Interest Groups are subgroups within
Fresno PC Users Group that meet on their schedules to discuss specific topics. Bring items to share,
programs, hints and blank disks. Email SIG leaders ahead to verify meeting times and locations.

Digital Photo SIG:

The Digital Photo SIG is held on the first Saturday of the month at CompUSA on N. Blackstone at
10:30am and is hosted by Nancy Mason and Jo Townley.
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Sanity Savers

Sanity Savers are members who have volunteered to help other members with their computing
problems. SIG Leaders are also a valuable information resource.

Do not expect long term counseling, house calls, or to get pirated copies of software recommended to
you. Also do not expect any of the volunteers to help you if you are not the legitimate owner of a
software package.

If you have any experience in an area of computing, feel free to add your name to the Sanity Saver's
list. You do not need to be an expert to be listed as a Sanity Saver--patience and willingness to help
count for a lot.

DOS Dean Mason & Krikor Geyoghlian
Excel Krikor Geyoghlian
General Computing Bill Myers
Internet Help Dean Mason
Audio Help Robert Caraway
Linux Ben Lutes
Lotus 1-2-3 Krikor Geyoghlian
Medical Cecil Bullard
MS Word Krikor Geyoghlian
Office 97/2000/XP Krikor Geyoghlian & Laura Barnard
Windows 3.x Krikor Geyoghlian

The Fine Print

The Fresno PC User's Group (FPCUG) is a non-profit organization run by and for users of IBM
compatible computers. The only membership eligibility requirement is an interest in computers.

FPCUG meetings are generally held the first Monday of the month at:

Hope Community Center
364 E. Barstow Avenue
Fresno, CA
(Fresno and Barstow)
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FPCUG Officers:

President Bill Myers
1st VP Stan Barnes
2nd VP Jo Townley
Secretary David Smith
Treasurer Wilda Moller
Directors At Large:

1 Regles Bellamy

2. Gary Gipson

3 Monica Braun

4. Brian Fulk
This newsletter was prepared using Macromedia HomeSite 5.5. Ronnie Ugulano is editor.

Contributions.While there's no guarantee that submitted material will be used, contributions to the
FPCUG Newsletter are appreciated. Articles of 200-500 words should be submitted in MS Word doc or
rtf format. Contributions can be in the form of an article written by a member or an article found on the
internet with permission to reprint. Any screenshots or photos should be sharp and high resolution, and
sent as jpgs, bmp, or tiff files, preferably not gifs. Files submitted as pdfs are likely to have their text
and graphics extracted as separate entities so that they can be converted to html format. Graphics might
be cropped or reduced to fit into available space. Contact Ronnie Ugulano for further information.

Reproduction Rights. Original articles may be reproduced by other computer users groups for
internal, non-profit use, provided credit is given to the Fresno PC Users Group and the author(s) of the
reproduced articles. This notice does not supersede the rights of authors whose copyrighted material is
used by permission.

Disclaimer. Trademarks used in this publication are hereby recognized and acknowledged. The
information provided in this newsletter is believed and intended to be correct and useful. However, the
Fresno PC Users Group cannot assume responsibility for errors contained in the articles or
misapplications of the information provided. Unless specifically stated otherwise, opinions expressed
are those of the individual author(s) and do not represent the opinions of, nor endorsement by, the
Fresno PC Users Group. The Fresno PC Users Group is an independent, non-profit users group and is
not affiliated in any way with any vendor or equipment manufacturer.

Vendor Notice. Only review products that have been obtained by the product review coordinator and
received through the FPCUG address shall be considered the responsibility of the FPCUG, unless
otherwise indicated by the Board of Directors and with the full knowledge of the review coordinator
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